Clinical Trials Recruitment
Dawn Nevarez
Recruitment Specialist
What we’ll cover today
Recruitment at little or no cost
Reaching diverse populations

- Right message
  - Reading level
  - Ad design
- Right person
  - Who are you looking for
  - What do they read, listen to, or watch
- Right timing & placement
  - Timing is everything
  - Placement of stories and ads
Right Message
Reading Level Ad Copy/Text

Message should be clear and direct;
- What is purpose of ad?
  - looking for people for research study
- What is the study for, how can it help
- Basic study inclusion/exclusion information
- Who to contact for more information or a link to a web page

Reading level on anything that goes out to the public should be at an 8th grade reading level.

How would you explain your study to your neighbor, who has basic or no science understanding.

**Reading Level – Flesch-Kincaid Grade Level**

MSWord: Review > Spelling & Grammar > after spell check > **Readability Statistics** pop-up
If **Readability Statistics** does not come up.
Go to File > Options > Proofing >
Under: When checking spelling and grammar in Word
• Check box: Show readability statistic
Back in your document, Review > Spelling & Grammar
• After spelling & grammar is finished the readability statistics will pop up
A Study to Compare Two Different Formulations of Mirikizumab in Healthy Participants

The purpose of this study is to compare two different formulations of mirikizumab in healthy participants. This study will compare how much of each formulation gets into the bloodstream and how long it takes the body to remove it. Information about any side effects that may occur will also be collected. Participants will remain in the study for about 12 weeks, after receiving study drug. Participants will be compensated.

Inclusion Criteria:
- Are overtly healthy males or females, as determined through medical history and physical examination

Exclusion Criteria:
- Must not have an average weekly alcohol intake that exceeds 21 units/week (males) and 14 units/week (females)
- Must not show evidence of active or latent tuberculosis (TB)
- Must not have received live vaccine(s) (including attenuated live vaccines and those administered intranasally) within 8 weeks of screening, or intend to during the study
- Must not have been treated with steroids within 1 month of screening, or intend to during the study
- Must not be immunocompromised
- Must not have significant allergies to humanized monoclonal antibodies

Study Coordinator: Jane Smith
Phone: 402-123-4567
Email: jane.smith@unmc.edu

UNMC is looking for health people for a psoriasis research study

Psoriasis is a condition in which skin cells build up and form scales and itchy, dry patches. The research study;
- will compare two different dosage amounts of a drug called mirikizumab
- will last for about 12 weeks
- Looking for men and women 19 – 75 years old who currently suffer from psoriasis
Participants will be compensated.

Contact Jane Smith for more information; 402-123-4567 or jane.smith@unmc.edu

11.5th grade reading level
Text heavy, it’s not going to be read. We don’t have the patience’s. You’ve lost me with the headline, must not be for me if I don’t understand the headline. Not professional looking, I question if this is really UNMC.

7.6th grade reading level.
Pictures help tell the story. It’s clear to the consumer what you are looking for/want. Easy to read, not imitating. Has a professional look and feel, I can trust them. It clearly show’s how you are.
Right Person
Who are you looking for - demographics

Who are you looking for?
- Male, Female or both
- Age range
- Healthy or with certain medical condition
- Ethnicity
- Time and location commitment
- How many and by when

UNMC is looking for health people for a psoriasis research study

Psoriasis is a condition in which skin cells build up and form scales and itchy, dry patches.
The research study:
- will compare two different dosage amounts of a drug called mirikizumab
- will last for about 12 weeks
- Looking for men and women 19 – 75 years old who currently suffer from psoriasis
Participants will be compensated.

Contact Jane Smith for more information;
402-123-4567 or jane.smith@unmc.edu

Male & Female
19 – 75 years old
All ethnicities
All socio-economic groups
12 weeks – weekly visits to the clinic
Current diagnosis of psoriasis
150 variety of ages & ethnicities
Need within one year
Right Person
Who are you looking for - demographics

Diverse Populations

UNMC is looking for health people for a psoriasis research study

Psoriasis is a condition in which skin cells build up and form scales and itchy, dry patches.
The research study;
- will compare two different dosage amounts of a drug called mirikizumab
- will last for about 12 weeks
- Looking for men and women 19 – 75 years old who currently suffer from psoriasis
Participants will be compensated.

Contact Jane Smith for more information;
402-123-4567 or jane.smith@unmc.edu

UNMC is looking for health people for a psoriasis research study

Psoriasis is a condition in which skin cells build up and form scales and itchy, dry patches.
The research study;
- will compare two different dosage amounts of a drug called mirikizumab
- will last for about 12 weeks
- Looking for men and women 19 – 75 years old who currently suffer from psoriasis
Participants will be compensated.

Contact Jane Smith for more information;
402-123-4567 or jane.smith@unmc.edu
Right Person
What do they read, listen to, or watch

Diverse Populations

Pockets of diversity in our community
   Omaha North Star free weekly newspaper
      Make sure your ad reflects that community
   Hispanic radio – build a relationship
      Make sure they get your press releases

Target marketing with Social Ads – As little as $50 a week
Registries are a great asset.

Great Plains IDeA-CTR is currently working on a general registry.
Right Placement & Timing
Getting in-front of them at the right time

Get in-front of them

Take advantage of Campus Resources
- Story in Campus Newsletter
- Slide for Campus Monitors
- Press Release to local media
- Science Café
- Ask UNMC
- Banners on Skywalks
- Conferences
- Post on main campus social media accounts;
  - Facebook Post – great for 40 yrs +
  - Facebook Live – 10 to 20 minutes discussing study
    - Visual background, props
  - Instagram – younger crowd

Timing

Think about what is going on at the time, sometimes you need to wait.
Examples

[Image of a webpage with text about Current Studies and a clinical trial spotlight for a walking study for women living with breast cancer.]

UNMC is seeking post-menopausal women living with breast cancer to participate in a study on physical activity, memory, and attention.

Visit bit.ly/ENLunmc or contact Lindsey Hanson – ENL@unmc.edu or 402.559.6870 to learn more!
Press Release possibilities

Radio Interviews
News Channel Nebraska – Central
Rural Daily Newspapers
Paid Social Ads

One week Facebook AD $75
Omaha market, 50 – 80 yrs. old
2,807 views
190 clicks
27 reactions*
23 Contacts – 8 eligible

One week Facebook AD $100
Omaha and surrounding areas
Women 18 – 50 yrs. old
7,490 views
247 clicks
68 reactions*
112 completed survey

*Like/Love/Share/Comment
Where to market?

Story Campus Wide Newsletter
Story in Department Newsletters
Press Release
Flyer/Brochure
Social Media
Conferences/Events/Walks
Community Partnerships
Campus Monitors
Registries
Science Café/Ask UNMC
Foundations put flyers in their office and at events
Take advantage of your systems patients – opt-in
Thank you

Contact me anytime –
Dawn Nevarez
402-836-9786
denevarez@unmc.edu
Epic – Research Recruitment Requests

Kara M. Smith, MS
College of Allied Health Professions
Process – Patient Perspective

- Patient opts in to be contacted
- Tickler email is sent to their personal email

Hello Rose,

You have been identified as a potential candidate for a research study. Please respond by logging into your One Chart | PATIENT account.

You may change your personal settings for these, and other notifications, after logging in.

You may change your research status at UNMC/Nebraska Medicine by contacting Patient Registration Services at 402-559-4222. You may still be contacted by providers on your care team regarding studies for which you may be eligible.
Available Studies

Based on your medical record, you have been identified as potentially eligible for these studies. Click "I'm Interested" to notify the research team that you may want to participate in the study. You may change your research status at UNMC/Nebraska Medicine by contacting Patient Registration Services at 402-559-4222. You may still be contacted by providers on your care team regarding studies for which you may be eligible.

OsteoBoost Belt Study

**Description**

Osteoporosis is a disease of the bones. It happens when you lose too much bone as you age and as a result, your bones become weak and may break. Women are at a greater risk of developing osteoporosis and broken bones.

We are investigating a device worn on a belt that delivers energy to the hips and spine that may help prevent bone loss.

**Links**

Click Here for More Information on the Spry Belt

Active Studies

You are not enrolled in any research studies or your research studies are not visible in One Chart | Patient.
Thank you for your interest in the Spry Belt Research Study that is studying how to prevent bone loss. In this study women will wear a hip energy device.

The next step is to see if you may be eligible.

- Find out more via our website https://www.unmc.edu/alliedhealth/research/projects/sprybelt and click “Screen Yourself Here” to see if you may be eligible
- Call our office at 1-402-559-6584 for further information or
- Respond to this email and let us know the best time to reach you.

Thank you for considering this opportunity.

Kara

Kara M. Smith, MS
Research Project Coordinator
Spry Belt Research Study
402-559-6513
https://www.unmc.edu/alliedhealth/research/projects/sprybelt/index.html
Planning

- Feasibility study / Query
  - # of patients who meet criteria
    - Active in patient portal
  - Request For Electronic Health Data: CCTR

- Approvals
  - VCR
  - IRB
  - My chart operations team

- One Chart Build
  - Create verbiage

Implementation

- Clinical Informatics implements
  - Tickler email
  - Clinical Informatics sends recruitment requests to portal

- Research Coordinator
  - Tracks response via One Chart In Basket
  - Follow up with interested patient
<p>| PAT_NAME | AGE | GENDER | Date Research Recruitment Request Sent | Interested | Contact 1 Date | Contact 1 Type | Prescreening Questionnaire # | Met Online Prescreening Criteria | Scheduled Screening Visit | Notes                  | Contact 2 Date | Comments       |
|----------|-----|--------|----------------------------------------|-------------|---------------|---------------|----------------------------|-------------------------------|------------------------|----------------|----------------|----------------|----------------|
| 59 Female| 51  | Female | 11/4/2019 Yes                          |             | 11/5/2019     | Email         |                            |                               |                        |                |                |                |
| 68 Female| 68  | Female | 11/12/2019 Yes                         |             | 11/14/2019    | Voicecall     | 714 No                     |                               |                        |                | Need to call |
| 53 Female| 79  | Female | 11/12/2019 Yes                         |             | 11/15/2019    | Phone         | 745 No                     |                               |                        |                |                |
| 67 Female| 67  | Female | 11/4/2019 Yes                          |             | 2/21/2020     | Email         |                            |                               |                        |                |                |
| 65 Female| 65  | Female | 8/28/2019 Yes                          |             | 10/29/2019    | Email         | 839                        |                               |                        |                |                |
| 67 Female| 67  | Female | 8/28/2019 Yes                          |             | 8/30/2019     | Email         | 319 No                     |                               |                        |                | 9/19/2019 Voice |
| 65 Female| 65  | Female | 8/28/2019 Yes                          |             | 8/30/2019     | Email         | 315 No                     |                               |                        |                |                |
| 56 Female| 56  | Female | 8/28/2019 Yes                          |             | 9/19/2019     | Email         | 311 No                     |                               |                        |                |                |
| 65 Female| 65  | Female | 8/28/2019 Yes                          |             | 8/30/2019     | Email         | 309 No                     |                               |                        |                | 9/17/2019 Voice |</p>
<table>
<thead>
<tr>
<th>Recruitment Method</th>
<th>Number of Subject Screened</th>
<th>Enrolled</th>
</tr>
</thead>
<tbody>
<tr>
<td>My recruitment requests</td>
<td>56</td>
<td>28</td>
</tr>
<tr>
<td>Email to HOPS participant</td>
<td>50</td>
<td>25</td>
</tr>
<tr>
<td>Postcard Mailing</td>
<td>41</td>
<td>18</td>
</tr>
<tr>
<td>Facebook</td>
<td>31</td>
<td>11</td>
</tr>
<tr>
<td>Referral – Family or friend</td>
<td>12</td>
<td>4</td>
</tr>
<tr>
<td>UNMC Today Article</td>
<td>8</td>
<td>3</td>
</tr>
<tr>
<td>Other</td>
<td>3</td>
<td>1</td>
</tr>
</tbody>
</table>
Pros

• Potential subjects come to you!
• Less labor during study
  • Trackable
  • Easy to manage
• Free / Low cost
• Text customizable

Challenges

• Labor intensive approval and set up process
Considerations for future use

• Query
• Timing

Contact:
• **One Chart Build:** Lindsie Buchholz, the Research Clinical Informatics Lead
• **Operating Procedures / Approvals:** Dawn Nevarez, Research Recruitment Specialist: denevarez@unmc.edu
• **Kara M. Smith,** ksmithm@unmc.edu
Recruiting and Retaining Participants from Community Based Samples

Devan Crawford
Director of Research Strategy, MHDI
Center Administrator, RDAR COBRE
University of Nebraska - Lincoln

This presentation was supported by the Minority Health Disparities Initiative, funded by the UNL Office of Research and Economic Development and Tobacco Settlement Funds and the Rural Drug Addiction Research Center, funded by the National Institute of General Medical Sciences of the National Institutes of Health [P20GM130461]. The content is solely the responsibility of the author and does not necessarily represent the official views of the National Institutes of Health or the University of Nebraska.
INTRODUCTION TO ME:  
Who I Am... Why Am I Here?

- Former Undergraduate Research Assistant
- Former Graduate Student in Sociology
- Former Project Manager for *MANY* CBPR projects
- Former Director of Research Analysis
- Current Director of Research Strategy for MHDI
- Current COBRE Administrator for RDAR Center Core
  - Spend ALOT of time assisting colleagues with design, development, and writing of IRB Protocols and Grant Applications

Don’t worry! I have wondered the same thing... like the time we moved buildings and I loaded an entire storage unit full of our family-based prevention supplies
INTRODUCTION TO THIS TOPIC:
It Takes A LOT of Commitment and Time

- Write
- Revise
- Adapt
- Discuss
- Modify
- Feedback
- Travel
- X infinity

The process is cyclical, indicated by the arrow returning to 'Feedback'.
SAMPLING CONSIDERATIONS

■ Know the Sampling “Area” and Population “Needs”
  – No Community Based Sample or Study Population is the Same
  – Understand the Country, State, Region, Language, Culture

■ Understand Potential Risks to Individuals Participating
  – What are Privacy and Confidentiality Concerns
  – How Will You Approach Recruitment and Future Participation

■ Increase Potential Benefits to Individuals Participating
  – What are Peoples Everyday Needs
  – What Other Information or Resources Can You Provide
SUCCESSFUL RECRUITMENT BEGINS WITH RESEARCHERS SPENDING THE TIME...

- Building Community Credibility
- Meeting Where People Are
- Being Available and Helpful
- Diversifying Recruitment Activities
SUCCESSFUL RECRUITMENT EXAMPLES

- Adult Women Experiencing Homelessness
  - Letters at Housing Locations for Introductions
  - Meal and Outdoor Locations for In-Person Discussions

- Youth Experiencing Homelessness in the Midwest
  - Social Service Providers for Introductions
  - Direct Street Outreach for In-Person Discussions

- American Indian Families in the Northern Midwest
  - Schools for Introductions
  - Community Events and Local Businesses for In-Person Discussions

- People Who Use Drugs in the Central Plains and Rural Puerto Rico
  - Peer Referral for Introductions
  - Safe Physical Spaces for In-Person Discussions
REMEMBER...

to even get to the retention phase you need the following:

- Active Engagement
- True Commitment
- Real Excitement
TO GET THERE...
MAKE PARTICIPATION AS EASY AS POSSIBLE!!
A FEW KEY PRINCIPLES OF RETENTION:

- A key to retention is listening to the communities and the participant population you are working with to best meet their needs for an excited and engaged experience with your research project. We have used the following:
  - Community Advisory Boards (CABs)
  - Community Research Councils (CRCs)
  - Prevention Research Councils (PRCs)

- If participants are committed to the research – and the planned outcomes of the research - they will be more likely to “stick with” longitudinal designs.
  - Use inclusive and non-stigmatizing language and materials
  - Understand the importance of study impacts outside academia
SUCCESSFUL RETENTION EXAMPLES

- Post-Cards
- Birthday Cards
- Useful Community Resources
- Snacks
- Safe Physical Spaces
- Letters
- Phone-Calls
- Text Messages
- Emails

- Magnets
- Mugs
- Bags
- Pencils/Pens
- Raffle Prizes
- Meals
- Coloring Books
- ID Cards
- Lanyards
MY CLOSING THOUGHTS!

1. Be willing to be flexible (and dare I say it... sometimes even be wrong)
2. Work with community stakeholders and members (especially when designing your study)
3. Don’t under-budget expenses for community recruitment or retention needs (especially staff time)
4. Ask a colleague you trust to review your plan (ask for honest critiques, even if it’s hard to hear)
5. Don’t assume past experiences will translate (small changes make big differences)
6. Always assume you don’t know (this forces you to listen often and be open to new perspectives)

Finally, it can be really hard (but it is extremely rewarding)
HOW TO REACH ME!!

There are MANY ways to reach me virtually...

- Send Me an Email (dcrawford3@unl.edu)
- Call Me on Skype (devan.m.crawford)
- Call Me at the Office (402-472-2243)
- Skype Business Message Me
- Microsoft Teams Message Me
- Find me on Basecamp and Slack